
 

 
 
 
 
 
 
 
 
 

 
Vehicle Titles and Registration Division 

Registration and Title System (RTS) 
Version 6.4.0 

 
Internet Vehicle Title and Registration Service (IVTRS) 

Version 3.5.0 
 

And 
 

Remote Sticker Printing System (RSPS) 
Version 1.9.0 

 

June 2010 
 
 



RTS 6.4.0, IVTRS 3.5.0 & RSPS 1.9.0 Release Notes 

June 2010 2 

CONTENTS 
 

At A Glance ................................................................................................................................ 3 

Local Options>Subcontractor Updates ....................................................................................... 3 

Vendor Plate Renewal Notice .................................................................................................... 4 
Non Vendor Plate Renewal Notice ........................................................................................................... 5 

Ordering Vendor Specialty Plates .............................................................................................. 5 

Vendor Plate Expiration and Prorated Fees ............................................................................... 6 
County Commissions ................................................................................................................................ 7 

Vendor Plates - Subcontractor Renewal .................................................................................... 7 

VTR 500 Receipt Modification .................................................................................................... 8 

NICUSA ..................................................................................................................................... 9 

Internet Renewal ........................................................................................................................ 9 

Email Addresses .......................................................................................................................10 

Off-Highway Use .......................................................................................................................11 
Original Titles .......................................................................................................................................... 11 
Corrected Title / Corrected Title Rejection ............................................................................................. 11 
Correct Title Rejection – Multiple Records ............................................................................................. 12 
Fee Description for ATV Fund and ATV STKR ...................................................................................... 12 

Admin Table Updates................................................................................................................13 
Combination ............................................................................................................................................ 13 
Seasonal Agriculture ............................................................................................................................... 13 
Rotary International Plates (RI) – Non - Qualifying Plate ....................................................................... 13 
New Vendor Specialty Plates ................................................................................................................. 13 

County Fixes and Activity Changes ...........................................................................................14 

Region and Headquarter Fixes and Activity Changes ...............................................................15 



RTS 6.4.0, IVTRS 3.5.0 & RSPS 1.9.0 Release Notes 

June 2010 3 

At A Glance 
This document describes new features, enhancements and defect corrections for the RTS 
6.4.0 IVTRS 3.5.0 and RSPS 1.9.0 release. The visible changes in the Registration and Title 
System (RTS), Internet Vehicle Title and Registration Service (IVTRS) and the Remote 
Sticker Printing System (RSPS) include: 
 

 RSPS  

 Vendor Plates  

 Internet Renewal Process 

 Off-Highway Use 

 Admin Table Updates 

 Fixes and Activity Changes 
 
Statewide distribution for this release is scheduled for June 14, 2010. 

Local Options>Subcontractor Updates 
Additional lines now appear in the Subcontractor Updates event to allow more information to 
the Name and Address fields. The following screens and reports will reflect the change. 

 Subcontractor Input (OPT003) screen 

 Subcontractor Entry (REG006) screen 

 Subcontractor Report  (the State now appears) 

 Subcontractor Receipt 
Subcontractor Input (OPT003) screen 
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Vendor Plate Renewal Notice  
Vendor plates are offered in 1, 5 and 10 year terms. Renewal notices were changed to include a 
new "plate term expiration" line and the barcode includes Plate Term Expiration Mo/Yr. The first 
notices with the new "plate term expiration" line will be daily or new owner notices and will begin 
appearing on or after May 22.  The first notices with vendor plate fees will be daily or new 
owner notices appearing on or after June 28.  The first regular monthly run with both plate 
expiration and vendor plate fees will be the October notices. 
 
 

 

RSPS barcode field 
includes: 

 Plate Term 
Expiration Mo/Yr 

 Vendor Plates, 
antiques and 
other Multi year 
plate renewals. 

CURRENT PLT TERM 
/ EXP MON/YR. 

Five and Ten Year 
Vendor Plates will 
not sync up until the 
end of the plate 
term. 
 
One year Vendor 
Plates will sync up 
with the RTS 6.4.0 
release. 

Plate Term/EXP. 
MON YR appears 
on Special Plate 
renewals 
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Non Vendor Plate Renewal Notice 
The renewal examples provided include current plate term for non-vendor plates. 
 
 
 

 
 

 
 
Vendor plate customers will have the option to renew for 1, 5 or 10 years at the end of their 
term. The system will indicate to county users which options are available.  However, 
subcontractors will NOT be able to make any changes; they will only be able to scan the 
renewal notice and collect the funds. 
Ordering Vendor Specialty Plates 
Vendor Plate Application Link  
County offices may process a vendor plate application for their walk-in customers through a 
direct link provided in RTS to a basic version of the MyPlates.com Web site. Like most Web site 
stores, the plate order involves choosing an item, putting it into a shopping cart, and submitting 
the credit card information. County users will go from RTS to MyPlates.com and come back into 
RTS through a series of screens. The order link is accessible on the RTS main menu by clicking 
Customer>Special Plates>MyPlates.com. Vendor plate order transactions completed at the 
county for customers will not appear on any reports. 
 
Once a vendor plate is ordered at a county through the link to MyPlates.com, the plate may be 
attached to the customer’s vehicle through RTS, just like non-vendor plates ordered through 
RTS. 
 

 

Special Plate Renewal 

No change to 
the renewals 
with regular 
plates 

Plate Term 
will appear on 
Special Plate 
renewals 

Regular Renewal 

 Payment is 
accepted by 
Credit Card only 

 For additional 
information on 
ordering a 
vendor plate, 
see Addendum 
provided with 
the Release 
Notes or call My 
Plates toll free 
at 888-769-7528 
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Vendor Plate Expiration and Prorated Fees  
The REG029 screen is used to enforce expiration/fee rules for vendor plates. Plate and 
registration do not have to be synched up-front for 5 and 10-year vendor plates. 

 A vendor plate can always expire after the current registration, but can never expire 
before the current registration expiration. 

 If the vendor plate expires before the current registration expiration, the “Vendor Plate 
Renewal” radio buttons on the REG029 screen will be enabled and the customer can 
pay a prorated plate fee (at the current term rate) to match up with the current 
registration. 

  At renewal, the customer may choose to renew their vendor plate for a 1-, 5-, or 10-
year term (at that term’s prices). 

 
RTS will take the same kind of automatic prorating actions when: 

 a 5 year vendor plate synchs in the 4th year to match up with the current registration. 

 a 10 year vendor plate synchs in the 9th year to match up with the current registration. 
 

Note: A One Year Term may be more than twelve months, when needed to synch with the 
current registration. 
 

 

When renewing a vendor 
plate at the REG029: 

 Counties should pay 
special attention the 
Vendor plate renewal: 
field to ensure the 
Plate Term is correct. 

 The New Plate Exp. 
Mo/Yr: is modified 
when a new plate term 
is selected, 
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County Commissions 
Counties will continue to see the .50 county commissions on the Apprehension Report 
ACC.4672 received with the Monday registration reports. 
 

 
Vendor Plates - Subcontractor Renewal  
New fields now appear in the Registration Subcontractor Renewal (REG007) screen and Modify 
Subcontractor Renewal (REG009) screen to allow manual keyboard entry/modification of 
vendor plate renewals. If the barcode on the renewal notice is scanned, all fields will 
automatically populate. 

 
 

The REG007 and REG009 
screens include new vendor 
plate information. 

 Plate Term 

 Current Plate Expiration 
Month and Year for 
vendor plates. 
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VTR 500 Receipt Modification  
Plate Expiration Dates and Plate Terms now appear for all Special Plates receipts. Previously, 
the expiration date printed only for Vendor plates. The following receipts reflect these changes:  

 Registration Renewal receipt 

 Registration Renewal-Subcontractor receipt 

 Vehicle Inquiry receipt 

 Internet Registration receipt 
 

 

The Confirmation 
Action CTL001 screen 
for verification of the 
registration fee has 
increased from 
$100.00 to $1,000.00 
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NICUSA  
The following link is primarily for counties participating in IVTRS. The RTS Main Menu now 
includes a link to NICUSA. The link provides access through RTS to the NICUSA payment 
processing website where enhanced versions of the Vendor Payment Report (VPR), Internet 
Deposit Reconciliation Report (IDRR), and other credit card reports are available. To access the 
site click on Customer>Registration Only>Internet Renewal>NICUSA.com. 
 

 
 
Internet Renewal  
The Recipient Address now appears in  the Vehicle Information and Processing REG103 
screen to reduce the time it takes to verify if the customer is Out of County instead of having to 
select View>Change Address. 
 

 

 Click on NICUSA 

 Login to NIC 

 Counties can view and 
print reports for all 
online transactions 
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Email Addresses  
A new field is available for adding or modifying an owner or renewal recipient email address. 
You may enter optional E-mail addresses for customer service purposes on the following 
screens: 

• Owner Entry TTL007 
• Inquiry Owner Addresses INQ006 
• Owner Address REG033 

• Recipient Address Information REG105 (Internet Renewal) 
Additionally, the State field on the Recipient Address Information REG105 is now an 
input field rather than a drop-down list. 

 
Note: The system copies the email address to Special Plate Information (SPL002) screen 
in the Special Plate Application when attached to vehicle. Additionally, an error message 
RTS000150 will appear if you enter a character not approved for use in RTS. 
 

 



RTS 6.4.0, IVTRS 3.5.0 & RSPS 1.9.0 Release Notes 

June 2010 11 

Off-Highway Use  

Original Titles 

 All Terrain Vehicles (ATVs) and Recreational Off-Highway Use Vehicles 
(ROVs) are properly titled when Original and Off-Highway Use are selected. 

 The system disables the Off-Highway Use checkbox when processing a transaction 
for Registration Purposes Only. 

 RTS prevents issuing registration for ATVs and ROVs that were previously 
registered. If you attempt to title an ATV/ROV that is properly marked as Off-
Highway Use, the following error messages will appear during registration: 

 

 

Corrected Title / Corrected Title Rejection 
The system disables the checkbox for Off-Highway Use when you select Corrected-
Original for the title type. If the title type should change, you should issue a new title. 
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The system disables the Record Not Applicable button on Title Record (TTL003) screen 
when Corrected Title - Original is selected on Title Types (TTL002) screen. 

 

Correct Title Rejection – Multiple Records 
When Multiple Records (INQ004) screen appears in the Correct Title Rejection event the 
Record Not Applicable checkbox no longer is available. 

 

Fee Description for ATV Fund and ATV STKR 
ATV Fund and ATV STKR are no longer in the Select Fees Description drop down 
menu found in Additional Collections/ Time Lag (ACC001) screen. 

 

Fee Descriptions 
Removed 

 ATV Fund 

 ATV STKR 
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Admin Table Updates 

Combination 
The plate number range for 2011, 2013, and 2015 Combination plates will now be 2MN001-
2XX999. VTR will now use new invalid letter combinations (PH, TT, TX, VD, XH, XP, and XY) 
for Combination plates. 

Seasonal Agriculture 
The plate number range for Seasonal Ag plates will now be 2XZ001-2ZZ999. 
 

Rotary International Plates (RI) – Non - Qualifying Plate 
Rotary International Plates are now available for passenger vehicles, trucks, motorcycles, 
trailers, travel trailers, and private buses. 

 ROTARY INT PLT 

 ROTARY INT MC PLT 

 ROTARY INT TRL PLT 

 ROTARY INT PB PLT 

 PER ROTARY INT PLT 

 PER ROTARY INT MC PLT 

 PER ROTARY INT TRL PLT 

 PER ROTARY INT PB PLT 

New Vendor Specialty Plates 
New plates and categories (A, C, D, MC, PB, and TR) offered for sale are: 

 GRIDIRON HEROES 

 ALPHA PHI ALPHA 

 TEXAS NAVY 

 TEXAS NAVY ADMIRAL 

 AUBURN UNIVERSITY 

 OKLAHOMA STATE UNIV 
 
All vendor specialty plates are available for passenger vehicles, trucks, motorcycles, trailers, 
travel trailers, and private buses. 
 
Note: When the county receives a vendor specialty plate, it is important to pay close attention to 
the label that comes with the plate. The label specifies the plate type you should select on the 
Class/Plate/Sticker Type Choice screen. 
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County Fixes and Activity Changes 
Primary 
Event 

Selection 

Secondary 
Event 

Selection 
Activity Description Status 

Customer 
Registration Only 

Renewal Problem: 
Validate Carrying capacity when 
changing registration. 

Fix Complete: 
Vehicle weight is validated 
upon transaction 
completion. 

Exchange  Problem: 
No Record Found appears when 
county tries to process an 
exchange after completing a 
vendor plate request prior to 
mainframe update. 

Fix Complete: 
Clerk can process an 
exchange to an ordered 
vendor plate for a customer 
prior to mainframe update.  

Subcontractor 
Renewal 

Problem: 
RTS allows process to continue 
when an Issue Date entered is 
less than the current year and 
the 90-day warning is ignored. 

Fix Complete: 
The Subcontractor renewal 
event will not accept an 
entry year less than the 
previous year. 

TxOnline Problem: 
Declined (refunded) record 
becomes lost once the internet 
user goes online again to renew. 

Fix Complete: 
The record reflecting a 
declined internet renewal 
will remain on reports when 
internet user goes online 
again to renew.  

Title/Registration 
 

Title Application 
 

Problem: 
Carrying Capacity is not clearing 
when transferring from PASS-
TRK (RegclassCD35) to PASS-
TRK (RegclassCD25). 

Fix Complete: 
RTS will reset Carrying 
Capacity when carrying 
capacity is not applicable 
for the vehicle class and 
registration class. 

Problem: 
When changing to Regular plate 
from regular exempt plates, the 
REG029 presents a minimum of 
6 months registration. 

Fix Complete: 
The REG029 now presents 
a minimum of 12 months in 
the title event when 
changing from Regular 
Exempt to Regular plates.  

Problem: 
The following screens display 
the “Select privacy act option” 
field: Title Additional Info 
TTL008, Miscellaneous Remarks 
TTL030 and Salvage TTL016. 

Fix Complete: 
The Privacy Act Option 
fields are removed.  

Problem: 
RTS: Title Application remains 
on the desktop when cancelling 
from multiple records.  

Fix Complete: 
Desktop menu will refresh 
and allow the clerk to see 
the VIN entered.  

Corrected Title Problem: 
Allows the option to change 
registration when record shows 
“Registration Invalid” or “TONLY” 
on Title Record (TTL003). 

Fix Complete: 
“Change Registration” is 
disabled in CORTTL when 
record shows “Registration 
Invalid” or “TONLY”.  
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Primary 
Event 

Selection 

Secondary 
Event 

Selection 
Activity Description Status 

Status Change Problem: 
On the Miscellaneous Remarks 
(TTL030) screen, RTS still 
allows Special Characters not 
approved for use in RTS in the 
“Registered By:” field. 

Fix Complete: 
Only approved characters 
are allowed. See 6.3.0 
Release Notes.  

 
Region and Headquarter Fixes and Activity Changes 

Primary 
Event 

Selection 

Secondary 
Event  

Selection 
Activity Description Status 

Customer 
Registration 

Special 
Plates/Renewal 

Problem: 
Unable to issue 2014 foreign 
organizational plates. RTS is 
prompting for 2009 plates. 

Fix Complete: 
When renewing a fixed 
expiration month in the 
month before registration 
expires, RTS prompts for 
the correct year of 
expiration.  

Title CCO Problem: 
When printing a CCO, the print 
is not aligned correctly on the 
Form 30-CCO Rev.6/2009. 

Fix Complete: 
 

COA Problem: 
COA record is not updated 
correctly in STATJK when 
multiple Junk records. 

Fix Complete: 
Vehicle record with more 
than one set of Junk data is 
updated via “Vehicle 
Junked” in Status Change.  
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